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Numerical Case Study Michaelis-Menten Enzyme Kinetics 

 
Michaelis-Menten Enzyme Kinetics 

 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Numerical.” 

 
What you will learn in this case study 
 

• How to change the name of the independent variable “t” to “s”. 
• How to create a Michaelis-Menten enzyme kinetic model. 
• How to fit the model to the data. 
• How to produce the Lineweaver-Burke, Hanes and Eadie-Hofstee plots. 
• How to deal with data replicates. 

 
Data Required 
 

The data file for this case study is 
 

diazep_r.dat 
 
The data file is a text file that is too large to be printed as part of the text. It is 
discussed below. 

 
Introduction 
 
This case study will show how to analyze data using the Michaelis-Menten equation. 
 
The Michaelis-Menten equation has the form 
 

v =
Vmax∗C
Km + C  

 
 
 
where v  is the velocity of the reaction, C  is the concentration of substrate, V  is the 
maximal velocity of the reaction, and 

max

Km

v = Vmax

 is the substrate concentration when 
2 .  The goal of an investigator is to estimate V  and max K/ m .   

 
This is often done by performing any of a number of transformations. The Lineweaver-
Burke is probably the most common one.  In this so-called double reciprocal plot, one 
writes 
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=
Km

Vmax

1
v

∗
1
C
+

1
Vmax

 

 
In other words, one transforms the data so that the reciprocal of the velocity can be 
plotted as a function of the reciprocal of the substrate concentration.  If a single 
Michaelis-Menten expression is appropriate for the data, the double reciprocal plot is a 
straight line from which it is easy to estimate V  and Km . max

 
Two other linearizing plots are the Hanes and Eadie-Hofstee. The Hanes equation is: 
 

 C
VV

Km *1

maxmax

+=
v
C  

 
and the Eadie-Hofstee equation is: 
 

maxV
C
vK m +⎟
⎠
⎞

⎜
⎝
⎛−=

max

v  

  
The Hanes equation is also a straight line whose slope is 1/Vmax and intercept Km/Vmax. 
The Eadie-Hofstee plot is a plot of v against v/s whose slope is Km and intercept Vmax 
on the v-axis and Vmax/Km on the v/s axis. The Eadie-Hofstee plot is useful in that it 
magnifies the departure of linearity (meaning there is more complexity than a single 
Michaelis-Menten term in the data) more than the Lineweaver-Burke plot 
 
These and other transformations have a tendency to produce estimates of V  and Km  
that are in error because the error structure in the data has not been handled properly in 
the transformation. More specifically, if d1 is a datum with standard deviation sd1, then 
the standard deviation of 1/d1 is not 1/sd1.  The result of these manipulations of the data is 
that smaller data end up with larger weights resulting in a skewing of the curve, and 
erroneous estimates of the desired parameters. 
 
In this case study, you will learn how to fit the Michaelis-Menten model directly to your 
data, thus eliminating the error problems caused by the transformation, and produce the 
desired transformation plots which are often more useful in presenting results. 
 
To create your Michaelis-Menten model, you have two choices. One is to use the 
Equation Builder in the SAAM II Numerical Toolbox. The other is to enter the 
equations directly, which is what we will do in this case study. 
 
To use the Equation Builder in the SAAM II Numerical Toolbox, you click on 
Equation Builder tool. The Equation Builder dialog box will open as follows: 
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If you select the Michaelis-Menten option and, for example, change the Number of 
Terms from “3” to “2”, the Equation Builder dialog box will appear as follows: 
 

 
 
If you now click Paste Equations, the following equations will appear on the SAAM II 
Numerical Working Canvas: 
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The first equation is the velocity reaction containing the linear term ka  where ka  is a 
parameter to be estimated, and two Michaelis-Menten terms where the two maximal 
velocities V  and V  and two half-saturation concentrations  and 

 (the equivalents of 

∗t

1a max2a Kd1a
Kd2a

max
Km

recip _

 in the Michaelis-Menten equation, and used 
interchangeably depending upon the situation) can be estimated from the data.  In this 
expression, the independent variable is written t ; this is concentration rather than the 
time.  The additional equations va  and t  let you set up the Lineweaver-
Burke plot. 

_ recip

 
In this case study, we will not use the predefined equations because we will use “s” 
instead of “t” as the independent variable. In addition, besides the Lineweaver-Burke 
plot, we will also show how to create the Hanes and Eadie-Hofstee plots. 
 
Before starting, we must comment on the data. The data used in this case study were 
generated using estimates for Km and Vmax taken from a paper describing the n-
demethylation of Diazepam by cytochrome P450's 2C and 3A41. The data were generated 
in triplicates. Data from enzyme (biochemical) type studies are often generated in 
replicates, and it is important to know how to deal with replicated data in SAAM II. 
 
The data from a single replicate are shown below: 
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s

10
20
40
60
80
100
120
140
160
180
220
240
260
280
300
320
340
360
380
400

sample1
0 n
5 7.77E-02

0.135
0.238
0.352
0.446
0.549
0.655
0.694
0.743
0.852
0.871
0.99
1.039
1.047
1.043
1.129
1.101
1.153
1.185
1.274
1.291  

 
Diazepam concentration is given in the “s” column and a measure of the velocity of the 
reaction is in the “sample1” column. These are the data that will be described by the 
Michaelis-Menten model. However, to produce the Lineweaver-Burke, Hanes and Eadie-
Hofstee plots, the data need to be transformed. The easiest way to do this is using a 
spreadsheet. 
 
To produce the Lineweaver-Burke plot, you need the reciprocal of the sample. We will 
call this smplrecip. This can be calculated by taking the reciprocal of each sample. In the 
data shown below, these appear in the column “smp1recip”. For the Hanes plot, you need 
the quotient of the concentration and velocity, s/sample1. These are given in the column 
“smp1sv” column below. Finally, for the Eadie-Hofstee plot, you need the quotient of the 
sample divided by the velocity, sample1/s. These appear in the column “smplvs”: 
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s sample1 smp1recip s
0 n
5 7.77E-02 12.870
10 0.135 7.407
20 0.238 4.202
40 0.352 2.841
60 0.446 2.242
80 0.549 1.821
100 0.655 1.527
120 0.694 1.441
140 0.743 1.346
160 0.852 1.174
180 0.871 1.148
220 0.99 1.010
240 1.039 0.962
260 1.047 0.955
280 1.043 0.959
300 1.129 0.886
320 1.101 0.908
340 1.153 0.867
360 1.185 0.844
380 1.274 0.785
400 1.291 0.775

mp1sv smp1vs
n n n

64.350 0.01554
74.074 0.01350
84.034 0.01190
113.636 0.00880
134.529 0.00743
145.719 0.00686
152.672 0.00655
172.911 0.00578
188.425 0.00531
187.793 0.00533
206.659 0.00484
222.222 0.00450
230.991 0.00433
248.329 0.00403
268.456 0.00373
265.722 0.00376
290.645 0.00344
294.883 0.00339
303.797 0.00329
298.273 0.00335
309.837 0.00323

ample2 sample3
n n n

.95E-02 7.70E-02
0.139 0.141
0.237 0.231
0.361 0.378
0.469 0.476
0.532 0.578
0.632 0.619
0.687 0.72
0.754 0.74
0.796 0.832
0.838 0.887
0.948 0.958
0.952 1.049
0.992 1.042
1.113 1.09
1.077 1.149
1.099 1.172
1.227 1.15
1.161 1.233
1.259 1.245
1.228 1.215

 
 
Such data are created for each of the replicates; these are in the data file diazep_r.dat. 
 
The totality of the data, i.e. the three sample replicates, are shown below: 
 

s sample1 s
0
5 7.77E-02 7
10 0.135
20 0.238
40 0.352
60 0.446
80 0.549
100 0.655
120 0.694
140 0.743
160 0.852
180 0.871
220 0.99
240 1.039
260 1.047
280 1.043
300 1.129
320 1.101
340 1.153
360 1.185
380 1.274
400 1.291  
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As noted above, to prepare for the three linearizing plots, the counterparts to smpl1recip, 
smpl1sv and smpl1vs need to be created. These are the data in diazep_r.dat. You will 
examine this data file in the case study; it is too large to reproduce here. 
 

 1. Kato and Yamazoe: Pharmacogenetics 4:359-362, 1994 
 
 
Part 1.  Analyze data from a process believed to exhibit Michaelis-Menten kinetics. 
 
In this part of the case study, you will plot the data to determine what kind of a 
Michaelis-Menten model you will use first. For the model, there are essentially three 
choices: a single Michaelis-Menten term, a single linear and a single Michaelis-Menten 
term, and two Michaelis-Menten terms. You would choose the first if the Lineweaver-
Burke and Eadie-Hofstee plots of the data are straight lines. You would choose the 
second if the last part of the data plot is a straight line. You would choose the last if the 
last part of the curve of the data still exhibited curvature, and neither the Lineweaver-
Burke nor Eadie-Hofstee plots are linear. Thus in examining the data, you will look at a 
plot of the data, and the Lineweaver-Burke and Eadie-Hofstee plots. 
 

1. Start the SAAM II Numerical application. The SAAM II Numerical main 
window will open as follows: 
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2. Specify the experimental attributes. 
 

a. In the Set menu, click Experimental Attributes. The Experimental 
Attributes dialog box will open. 

 
b. In the Independent Variable box, rename “t” to “s”. 
 
c. In the Units box, type “concentration”.   
 
d. In the End At box, enter “400”. The Experimental Attributes dialog box 

will appear: 
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e. Click Done. 
 

3. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file diazep_r.dat should appear in the list 

(if it does not, find the folder where you put this data file). 
 
c. Double-click diazep_r.dat. The data in this file will appear in the Data 

window in part as follows: 
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 The data file. The contents of the data file have been explained in the 
introduction. The first column is the concentration; the next three are the 
actual data while the remaining columns are transformed data that will permit 
the Lineweaver-Burke, Hanes and Eadie-Hofstee plots. 

 
 

d. Close the Data window. 
 

4. View your data using a line plot. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. 
 
b. Be sure the List All Variables check box is selected. (Click this box if it is 

not selected). 
 
c. Press the Ctrl key, and click sample1, sample2 and sample3 to move these to 

the Current Selection pane. The Plot and Table Variables dialog box will 
appear as follows: 
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 Note the name of the variable on the X-Axis is “s”, the name of the 
independent variable you assigned in the Experimental Attributes dialog 
box. 

 
d. Click Done. A plot of the data will appear in the Plot window. It is useful to 

change the scale. 
 
e. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. Change the Y-Axis scale as shown in the follow Plot and 
Table Scale dialog box: 

 

 
 
f. Click Done.   
 
g. In the View menu, click Line Plot. If the plot is not in linear mode, in the 

View menu, click Semilog to make the plot linear. Your plot will appear as 
follows: 
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You can see there is still some curvature towards the end of the data, so a 
linear component to your model (discussed below) will not be tested. 

 
h. Close the Plot window. 

 

  Line Plots. The data can be visualized as a linear or semilog plot after they 
have been loaded into the SAAM II Data window. This can be very useful in 
helping you decide with which model you would like to start your data 
analysis 

 
 

5. View your data using the Lineweaver-Burke and Eadie-Hofstee plots. 
 

Remember the Lineweaver-Burke equation is: 
 

K1
v
= m

Vmax

∗
1
C
+

1
Vmax

 

 
In our model, “s” will play the role of “C” in the equation. So the Lineweaver-
Burke plot is a plot of “1/s” versus 1/v. The data have already been entered in the 
Data window transformed for this plot; they are called “smp1recip”. Thus to 
produce the Lineweaver-Burke plot, we need to specify “1/s”. This is done by 
entering an equation on the Working Canvas. 
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a. Type the following on the Working Canvas:  
 

# 
# The following equation defines a variable for the Lineweaver-Burke plot. 
# The addition of the term "0.00001" in the denominator for s_recip will  
#    prevent division by zero when s = 0. 
# 
s_recip = 1/(s + 0.00001) 
# 

 
  The Working Canvas will appear, in part, as follows: 
 

 
 

 Comments in SAAM II Numerical. Comment lines can be added to your 
equation set by starting the comment line with the pound key “#”. 

 
 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Your previous plot of the data (no line plot) should appear. 
 
c. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog bow will open. Be sure the List All Variables check box is selected. 
(Click this box if it is not selected). 

 
d. Type “s_recip” in the X-Axis box (this will change the variable on the X-Axis 

from “s” to “s_recip.) 
 
e. Click smp1recip, and then press the Ctrl key, and click smp2recip and 

smp3recip in the Variable for Y-Axis pane to move these to the Current 
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Selection pane. The Plot and Table Variables dialog box will appear as 
follows: 

 

 
 
f. Click Done. The Plot window will appear with nothing in it. This is because 

SAAM II remembers the plot scale you set previously when you examined the 
data. You need to reset the plot scale. In addition, you need to Solve in order 
to activate the equation “s_recip = 1/(s + 0.00001). 

 
g. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
h. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. Change the X-Axis and Y-Axis scales as shown in the follow 
Plot and Table Scale dialog box: 
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 Setting the X-Axis scale. The reason why the X-Axis scale had to be changed 
was because you were plotting (1/s) as the variable. The values for “s” range 
from “0” to “400”. Of course there is no “1/0” possible, so SAAM II 
substituted a very large number. The first datum for “s” was “5” the reciprocal 
of which is 0.2. Choosing “0.25” as the Maximum just gives a little more 
room on the plot. 

 
 
i. Click Done.  Your plot will appear as follows: 
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You can see this plot is not linear, so more than one Michaelis-Menten term 
will be required in your model. If you create a line plot of these data, the 
deviation from a straight line, especially at the beginning, will be evident. 

 
j. Leave the Plot window open. 
 

You will now examine the Eadie-Hofstee plot. Remember the Eadie-Hofstee equation 
is: 
 

maxV
C
vK m +⎟
⎠
⎞

⎜
⎝
⎛−=v  

 
Remembering “C” is replaced by “s” in our model, this is a plot of the data divided by 
“s” versus “s”. The corresponding “v/C” has been calculated in the Data window; it 
is in the column named “smpl1vs”. 

 
k. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
 
l. Type “s” in the X-Axis box (this will return the variable on the X-Axis from 

to “s” from “s_recip.) 
 
m. Click smp1vs, and then press Crtl, and click smp2vs and smp3vs, in the 

Variable for Y-Axis pane to move these to the Current Selection pane. The 
Plot and Table Variables dialog box will appear as follows: 
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n. Click Done. You will need to reset your plot scale as follows: 
 

 
 
o. Click Done. Your Eadie-Hofstee plot will appear as follows: 
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It is clear this plot is not linear; it is even more obvious than with the 
Lineweaver-Burke plot. Thus the data contain more complexity than a single 
Michaelis-Menten term. 

 
p. Close the Plot window. 
. 

 
Part 2. Specify the model of the data 
 
Your pre-analysis of your data have led you to the conclusion that your initial model 
should contain two Michaelis-Menten terms. If you were unsure about whether a linear 
term was needed, you could first start with a linear plus a single Michaelis-Menten term. 
You will use the two Michaelis-Menten term model. 

 
1. Specify the model for the data. 
 

Type the following on the Working Canvas below your initial equation for 
“s_recip”: 
 
# 
# Michaelis-Menten model with two terms 
# 
v1 = (Vmax1*s)/(Km1 + s) + (Vmax2*s)/(Km2 + s) 
v2 = v1 
v3 = v1 
# 
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Your Working Canvas will appear in part as follows: 
 

 
 

 Working with data replicates. In SAAM II, you can associate only one 
variable with a data name. In the case of data replicates, you need to have one 
variable for each replicate. The model is given by the equation for v1. v1 as a 
variable can be associated with sample1. In order to have a variable for 
sample2 and sample3, you need to create two new variables which are equal 
to the first. This is accomplished by the equations “v2 = v1” and “v3 = v1”. 

 
 

2. Associate the data and variable. 
 

a. In the Show menu, click Associations. The Associate Variables and Data 
dialog box will open as shown in the following: 

 

 
 

©University of Washington MMR Enzyme - 19 Rev. 03/06/20 



Numerical Case Study Michaelis-Menten Enzyme Kinetics 

Note the entries in the Data Names box are the names of the columns in your 
data file. 

 
b. In the Variable Names (&Associated Data) box, click v1. 
 
c. In the Data Names box, click sample1. 
 
d. Click Associate.  
 
e. In the Variable Names (&Associated Data) box, click v2. 
 
f. In the Data Names box, click sample2. 
 
g. Click Associate. 
 
h. In the Variable Names (&Associated Data) box, click v3. 
 
i. In the Data Names box, click sample3. 
 
j. Click Associate. The Associate Variables and Data dialog box will appear 

as shown below: 
 

 
. 
k. Click Done. 

 
3. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively click the Parameter 

 tool on the SAAM II Toolbar.  The Parameters dialog box will open as 
shown below: 
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There are four parameters to be estimated from the data, Vmax1, Vmax2, Km1 
and Km2. These are the four parameters describing the two Michaelis-Menten 
terms. 

 
b. Enter the parameters as shown in the following Parameters dialog box: 
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c. Click Done. 

 
4. Solve the model, and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively click the Solve  tool on 
the SAAM II Toolbar. 

 
b. Plot the data. In the Show menu, click Plot, or alternatively click the Plot tool 

 on the SAAM II Toolbar.  The Plot and Table Variables dialog box 
will open. (Remember your last plot was the Eadie-Hofstee plot. However, 
you added the model equation after that plot. Thus when you plot after adding 
the equation, the previous plot will not open.) Be sure the List All Variables 
box is not checked. 

 
c. Press Ctrl, and click v1:sample1, v2:sample2 and v3:sample3 to move these 

to the Current Selection window. 
 

d. Click Done.  The following plot will appear: 
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 Notice the autoscale option is active for the plot scale; you can change it if 

you wish to better visualize the last few data. Notice also that v1, v2 and v3 
appear superimposed on themselves. 

 
 Leave the Plot window open. 

 
5. Fit the model to the data, view the solution and statistics. 
 

a. In the Compute menu, click Fit, or alternatively click the Fit  tool on the 
SAAM II Toolbar.  Your plot will be updated as follows: 
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b. In the Show menu, click Statistics, or alternatively, click the Statistics  
tool on the SAAM II Toolbar.  With the plot open, the Working Canvas will 
appear (after moving some windows around) as follows: 
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You can see that the model provides a very good description of the data, and 
that the parameters are well estimated. 

 
c. Close the Statistics window. Leave the Plot window open. 

 
Part 3. Create the Lineweaver-Burke, Hanes and Eadie-Hofstee plots. 
 
While you examined the Lineweaver-Burke and Eadie-Hofstee plots of the data, you will 
now create these with the model predicted values as well as the Hanes plot. 
 

1. Create the Lineweaver-Burke plot. 
 
To produce the Lineweaver-Burke plot, you need to add another equation to 
produce the model calculated “1/v1”. 

 
a. Type the equation “v1_recip = 1/v1” under your equation for “s1_recip”; your 

Working Canvas will appear as follows: 
 

 
 

You do not need to calculate the reciprocals of v2 or v3 as you only need 
one model calculated value for this reciprocal.  
 
Notice the plot will disappear. 

 
b. Re-Solve the model. 
 
c. In the Window menu, click Plot. Your plot will reappear on the Working 

Canvas, and be active. 
 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is selected. 
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e. Type “s_recip” in the X-Axis box. 
 
f. Click v1_recip, and then press Ctrl and smp1recip, smp2recip and 

smp3recip. The Plot and Table Variables dialog box will appear as follows: 
 

 
 

g. Click Done. Your plot will not be useful as, when you plotted the data, you 
need to change the scale. 

 
h. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
i. Set the X-Axis minimum and maximum values to 0.0 and 0.25 respectively. 

Set the Y-Axis minimum and maximum values to 0.0 and 16.0 respectively. 
The Plot and Table Scale dialog box will appear as follows: 
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j. Click Done. Your Lineweaver-Burke plot will appear as follows: 
 

 
 

 
2. Create the Hanes plot 

 
To create the Hanes plot, you need to add another equation for the model 
calculated value for “s/v”. 

 
a. Type the following on your Working Canvas: 

 
# 
# Setting up the Hanes plot 
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# 
Hanes = s/v1 
# 
 
Your Working Canvas will appear as follows: 

 

 
 
b. Re-Solve the model. 
 
c. In the Window menu, click Plot. Your plot will reappear on the Working 

Canvas, and be active. 
 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is selected. 
 
e. Type “s” in the X-Axis box. 
 
f. Click Hanes, and then press Ctrl and click smp1sv, smp2sv and smp3sv. The 

Plot and Table Variables dialog box will appear in part as follows: 
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g. Click Done. Your plot will not be useful because the scale is set for the 
Lineweaver-Burke plot. 

 
h. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
i. Change the settings as follows: 

 

 
 

j. Click Done. Your Hanes plot will appear as follows: 
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3. Create the Eadie-Hofstee plot 

 
To create the Eadie-Hofstee plot, you need to add another equation for the model 
calculated value for “v1/s”. 

 
a. Type the following on your Working Canvas: 

 
# 
# Setting up the Eadie-Hofstee plot 
# 
Eadie = v1/s 
# 
 
Your Working Canvas will appear as follows: 
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b. Re-Solve the model. 
 
c. In the Window menu, click Plot. Your plot will reappear on the Working 

Canvas, and be active. 
 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is selected. 
Remember “s” is still the variable in the X-Axis box. 

 
e. Press Ctrl and click Eadie, smp1vs, smp2vs and smp3vs.  You will need to 

scroll in the Variable for Y-Axis pane to find all the variables. The Plot and 
Table Variables dialog box will appear in part as follows: 
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f. Click Done. Your plot will not be useful because the scale is set for the Hanes 
plot. 

 
g. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
h. Change the settings as follows: 

 

 
 

i. Click Done. Your Eadie-Hofstee plot will appear as follows: 
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j. Close all open windows. 
 
Quit the SAAM II Numerical application. You can save the numerical study file if you 
wish. 
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Essential Points to Remember 
 

• It is best to fit your “enzyme” kinetic data directly to a Michaelis-Menten model. 
That is, it is not necessary to transform you data to obtain the model parameter 
estimates (which is difficult if your model contains more than one Michaelis-
Menten term.) 

• You can easily plot your results in a transformed mode. This will require 
transforming your data, and writing the appropriate model equation. 

• It is easy to deal with data replicates; you must have a separate variable name for 
each data name. 
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